
Chapter 13

Hatching Drawings

After completing this chapter, you will be able to:
• Use the HATCH command to hatch an area using various patterns.
• Use the boundary hatch with predefined, user-defined, and custom hatch patterns as options.
• Specify pattern properties.
• Preview and apply hatching.
• Use advanced hatching options and Ray Casting.
• Edit associative hatch and hatch boundary using HATCHEDIT command, PROPERTIES
   palette, and Grips.
• Hatch inserted blocks.
• Align hatch lines in adjacent hatch areas.
• Hatch by using the -HATCH command at the Command prompt.

Learning Objectives
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Figure 13-1  Illustration of hatching

HATCHING
In many drawings, such as sections of solids, the sectioned area needs to be filled with some
pattern. Different filling patterns make it possible to distinguish between different parts or
components of an object. Also, the material of which an object is made, can be indicated by the
filling pattern. You can also use these filling patterns in graphics for rendering architectural
elevations of buildings, or indicating the different levels in terrain and contour maps. Filling
objects with a pattern is known as hatching (Figure 13-1). This hatching process can be
accomplished by using the HATCH command or the TOOL PALETTES window.

Before using the HATCH command, you need to understand some terms that are used when
hatching. The following subsection describes some of the terms.

Hatch Patterns
AutoCAD LT supports a variety of hatch patterns (Figure 13-2). Every hatch pattern is composed
of one or more hatch lines or a solid fill. The lines are placed at specified angles and spacing.
You can change the angle and the spacing between the hatch lines. These lines may be broken
into dots and dashes, or may be continuous, as required. The hatch pattern is trimmed or
repeated, as required, to fill exactly the specified area. The lines comprising the hatch are drawn
in the current drawing plane. The basic mechanism behind hatching is that the line objects of
the pattern you have specified are generated and incorporated in the desired area in the drawing.
Although a hatch can contain many lines, AutoCAD LT normally groups them together into an
internally generated object and treats them as such for all practical purposes. For example, if
you want to perform an editing operation, such as erasing the hatch, all you need to do is select
any point on the hatch and press ENTER; the entire pattern gets deleted. If you want to break
a pattern into individual lines to edit them, you can use AutoCAD LT’s EXPLODE command.
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Figure 13-2  Some hatch patterns

Hatch Boundary
Hatching can be used on parts of a drawing enclosed by a boundary. This boundary may be
lines, circles, arcs, polylines, 3D faces, or other objects, and at least part of each bounding
object must be displayed within the active viewport.

HATCHING DRAWINGS USING THE HATCH DIALOG BOX

The  HATCH  command allows you to hatch a region enclosed within a boundary
(closed area) by selecting a point inside the boundary or by selecting the objects to be
hatched. This command automatically designates a boundary and ignores any other
objects (whole or partial) that may not be a part of this boundary. When you invoke the

HATCH command, the Hatch dialog box is displayed, as shown in Figure 13-3. You can also
enter HATCH at the pointer input to invoke the Hatch dialog box. The default appearance of
the Hatch dialog box is a little different from the one shown in Figure 13-3. That is because
options like Islands, Boundary Retention are not visible by default. To make these options
visible select the More Options button available in the lower right hand corner. You can perform
the hatching operation using this dialog box.

Toolbar: Draw > Hatch
Menu: Draw > Hatch
Command: HATCH or BHATCH
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In this example, you will hatch a circle using the default hatch settings. Later, in the chapter you
will learn how to change the settings to get a desired hatch pattern.

1. Invoke the Hatch dialog box by choosing the Hatch button on the Draw toolbar.

2. Choose the Pick Points button in the Hatch dialog box. The dialog box temporarily closes.

3. Select a point inside the circle (P1) (Figure 13-4) and press ENTER. The Hatch dialog box is
displayed again. You can now preview the hatching by choosing the Preview button. After
specifying an internal point, you can also right-click to display a shortcut menu and select the
Preview option.

4. After checking the preview, press ESC to complete the point specification; the dialog box
reappears. You can also right-click to apply the hatch without invoking the dialog box.

5. Choose OK to apply the hatch to the selected object, Figure 13-5.

Example 1 General

Figure 13-3  The Hatch dialog box



Hatching Drawings                                                               13-5

©
 C

A
D

C
IM

 T
ec

hn
ol

og
ie

s,
 U

S
A

. F
or

 e
ng

in
ee

ri
ng

 s
er

vi
ce

s,
 c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

Tip
The FILLMODE system variable is set to On by default (value of the variable is 1) and hence
the hatch patterns are displayed. In case of large hatching areas, you can set the FILLMODE
to Off (value of the variable is 0), so that the hatch pattern is not displayed and the regeneration
time is saved.

You can also hatch a selected face of a solid model. However, to hatch a face of the solid model, you
need to align the UCS at that face. You will learn more about this in later chapters.

HATCH DIALOG BOX OPTIONS
The Hatch dialog box has several options that let you control the various aspects of hatching,
such as pattern type, scale, angle, boundary parameters, associativity, and so on. The following
is a description of these options.

Type and pattern Area
This area contains the options that allows you to  choose the type of pattern and preview the
chosen pattern type.

Type. The Type drop-down list (Figure 13-6) displays the
types of patterns that can be used for hatching drawing
objects. This list lets you choose the type of hatch pattern
you want. The three types of hatch patterns available are
Predefined, User defined, and Custom. The predefined
type of patterns come with AutoCAD LT and are stored in
the acad.pat and acadiso.pat files. The predefined type of
hatch pattern is the default type. When you select User
defined from the Type drop-down list a pattern of lines that is based on the current linetype is
created. You can set the angle of the lines in the pattern and also the spacing between them.
When you select Custom from the Type drop-down list, you can select a pattern that has been
defined in a custom PAT file.

Figure 13-6  The Type drop-down
list displaying hatch pattern types

Figure 13-4  Specifying a point to hatch the circle Figure 13-5  Drawing after hatching
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Note
When using the patterns defined in the custom PAT files, make sure that their search path has
been added in the Files tab of the Options dialog box.

Pattern. The Pattern drop-down list displays the names of all the predefined patterns
available in AutoCAD LT. You can select any pattern from this list and the selected pattern is
displayed in the Swatch box. The selected pattern is stored in the HPNAME system variable.
ANSI31 is the default pattern in the HPNAME system variable. The Pattern drop-down list is
available only if you have selected Predefined from the Type drop-down list.

To select a particular hatch pattern, you can also choose the [...] button that displays the
Hatch Pattern Palette dialog box (Figure 13-7). This dialog box shows the images and names of
the available hatch patterns. This dialog box is also displayed by clicking on the pattern displayed
in the Swatch box. The Hatch Pattern Palette dialog box has four tabs. They are described next.

ANSI. This tab displays all the ANSI (American National Standards Institute)-defined hatch
patterns that come with AutoCAD LT. ANSI31 is the default pattern.

ISO. This tab displays all the ISO (International Standard Organization)-defined hatch
patterns that come with AutoCAD LT.

Other Predefined. This tab displays all the predefined hatch patterns other than ANSI- or
ISO-defined patterns.

Figure 13-7  The Hatch Pattern Palette dialog box (ANSI tab)
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Custom. This tab displays all the custom patterns described in any custom PAT file that is
added in the search path of AutoCAD LT 2006.

Tip
Using the Hatch Pattern Palette dialog box for selecting a hatch pattern is more convenient
since you can view all the pattern names and the corresponding patterns simultaneously.

Swatch. This box displays the selected pattern. When you click in the Swatch box, the Hatch
Pattern Palette dialog box is displayed.

Custom Pattern. This drop-down list is available only if you have selected Custom from the
Type drop-down list. It displays all the available custom hatch patterns defined in the custom
PAT files that have been added to the AutoCAD LT search path. The recently used custom hatch
patterns in a current drawing session appear in the list. The selected pattern is stored in the
HPNAME system variable. You can also choose the [...] button; the Hatch Pattern Palette dialog
box (Custom tab) appears. This tab displays the custom pattern paths.

Angle and scale Area
The options in the Angle and Scale area are discussed next.

Angle. The Angle drop-down list (Figure 13-8) displays
the angles (at an increment of 15-degree) by which you
can rotate the hatch pattern with respect to the X axis
of the current UCS. You can select any angle from this
drop-down list or you can also enter an angle of rotation
of your choice in the Angle edit box. The angle value
is stored in the HPANG system variable. The angle of
hatch lines of a particular hatch pattern is governed by the values specified in the hatch definition.
For example, in the ANSI31 hatch pattern definition, the specified angle of hatch lines is
45-degree. If you select an angle of 0, the angle of hatch lines will be 45-degree. If you enter an
angle of 45-degree, the angle of the hatch lines will be 90-degree.

Scale. The Scale drop-down list (Figure 13-8) displays scale factors by which you can expand
or contract the selected hatch pattern. The scale factors that are displayed range between 0.25 to
2 at increments of 0.25. You can also enter the scale factor of your choice in the Scale edit box.
The Scale drop-down list is not available when you are using user-defined hatch patterns. The
scale value is stored in the HPSCALE system variable. A value of 1 does not mean that the
distance between the hatch lines is 1 unit. The distance between the hatch lines and other
parameters of a hatch pattern is governed by the values specified in the hatch definition. For
example, in the ANSI31 hatch pattern definition, the specified distance between the hatch lines
is 0.125. If you select a scale factor of 1, the distance between the lines will be 0.125. If you enter
a scale factor of 0.5, the distance between the hatch lines will be 0.5 X 0.125 = 0.0625.

Relative to Paper Space. If this check box is selected, then AutoCAD LT 2006 will automatically
scale the hatched pattern relative to the paper space units. This option can be used to display

Figure 13-8  The Angle and Scale
drop-down lists
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the hatch pattern at a scale that is appropriate for your layout. This option is available only in a
layout.

ISO Pen Width. The ISO pen width drop-down list is available only for ISO hatch patterns.
You can select the desired pen width value from the ISO pen width drop-down list. The value
selected specifies the ISO-related pattern scaling.

User defined Hatch Patterns
To define a simple pattern, you can select User defined from the Type drop-down list. You
will notice that the Angle and Spacing edit boxes and the Double check box are available in the
dialog box. The Scale drop-down list is not available.

Angle
Just as with predefined patterns, you can specify in the Angle edit box an angle with respect to
the X axis of the current UCS through which the hatch pattern is rotated. This value is stored in
the HPANG system variable.

Double
This check box is available only for user-defined patterns. When you select this check box,
AutoCAD LT doubles the original pattern by drawing a second set of lines at right angles to the
original lines in the hatch pattern. For example, if you have a parallel set of lines as a user-defined
pattern and if you select the Double check box, the resulting pattern has two sets of lines
intersecting at 90-degree. You can notice the effect of selecting the Double check box in
Figure 13-9. If the Double check box is selected, the HPDOUBLE system variable is set to 1.

Spacing
The Spacing edit box is available only when you have selected User defined from the Type
drop-down list. The value you enter in the Spacing edit box sets the spacing between the lines in
a user-defined hatch pattern. This spacing is stored in the HPSPACE system variable. The
default spacing value is 1.0000.

Custom Hatch Patterns
When you select Custom from the Type drop-down list in the Hatch dialog box, you will notice
that the Custom pattern drop-down list is available. The Angle and Scale drop-down lists are
also available.

Custom pattern
In AutoCAD LT, hatch patterns are normally stored in the file named acad.pat. You can select a
hatch pattern from an individual file by selecting Custom from the Type drop-down list. The
Custom pattern drop-down list is available now. You can choose the [...] button to display the
Custom tab of the Hatch Pattern Palette dialog box. Here, the list box on the left side of the
dialog box displays the paths of the custom hatch patterns. When you select a path, the
corresponding pattern is displayed in a preview window on the left. Choose OK to return to the
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Figure 13-9  Specifying angle and spacing for user-defined hatch patterns

Hatch dialog box. The corresponding pattern is displayed in the Swatch window. You can also
select a pattern from the Custom pattern drop-down list. You can also enter the name of the
custom pattern in the field, if you know the name of the hatch pattern. The name is held in the
HPNAME  system variable. If AutoCAD LT does not locate the entered pattern in the acad.pat
file, it searches for it in a file with the same name as the pattern. You can specify an angle and
scale for the custom pattern using the Angle and Scale drop-down lists, as in the case of
predefined patterns.

Tip
When you are hatching large areas, it is better to use a larger scale factor for the hatch pattern
that will help you save time regenerating and plotting. Also, when using a larger scale factor
for the hatch pattern, the drawing appears to be neater and not too cluttered.

In this exercise, you will hatch the given drawing using the hatch pattern named STEEL. Set the
scale and the angle to match the drawing shown in Figure 13-10.

Exercise 1 Mechanical
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Selecting Hatch Boundary
The boundaries selection options in the Hatch dialog box allow you to define the hatch boundary.
This is done by selecting a point inside a closed area to be hatched or by selecting the objects.
There are other options also available here for removing islands, viewing the selection, using
properties from an existing hatched object, and controlling associativity of the hatch pattern.

Boundaries Area
The options under Boundaries Area of Hatch dialog box are discussed next.

Add: Pick points. When you choose this button, AutoCAD LT automatically constructs
a boundary from the objects that form a closed area. This is the easiest method to specify
a region for hatching. When you choose the Add: Pick Points button, the dialog box

disappears temporarily to allow you to select a point within the closed area to be hatched. Select
a point inside the object and a boundary is defined around the selected point. The following
prompts appear when you choose the Add: Pick Points button in the Hatch dialog box.

Pick internal point or [Select objects/remove Boundaries]: Select a point inside the object to
hatch.
Selecting everything visible...
Analyzing the selected data...
Analyzing internal islands...
Pick internal point or [Select objects/remove Boundaries]: Select another internal point or press
ENTER to end selection.

You can also select objects or remove boundaries from the existing selection to define the hatch
boundary. To select objects enter S at the Pick internal point or [Select objects/remove Boundaries]
prompt. Now, you can select the objects to define hatch boundary. The prompt sequence is
given next.

Figure 13-10  Drawing for Exercise 1
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Pick internal point or [Select objects/remove Boundaries]: S �
Select objects or [picK internal point/remove Boundaries]: Select the object to hatch.
Select objects or [picK internal point/remove Boundaries]: Select another object to hatch or
press ENTER to end selection. .

Enter K at the Select objects or [picK internal point/remove Boundaries] prompt to specify the
hatch boundary by picking the internal point or enter B to remove the boundaries from the
existing selection. The prompt sequence when you enter B is given next.

Select objects or [picK internal point/remove Boundaries]: B �
Select objects or [Add boundaries]: Select objects to clear from selection
Select objects or [Add boundaries/Undo]: Select objects to clear from selection or press
ENTER to end selection.

To add the boundaries, enter A at the Select objects or [Add boundaries] prompt. As you enter
A at the specified prompt, you will be routed back to the Pick internal point or [Select objects/
remove Boundaries] prompt. To undo the last selection of boundaries, enter U at the Select
objects or [Add boundaries/Undo] prompt.

Once the internal points have been selected, press ENTER or choose the ENTER option from
the shortcut menu and the dialog box reappears. Choose OK to apply the hatch pattern to the
region. If you want to hatch an object and leave another object contained in it without hatching,
select a point inside the object you want to hatch. By default, when using the HATCH command,
selecting a point creates multiple boundaries; a boundary of the internal object is also created,
and the region between these two boundaries is selected for hatching. In Figure 13-11, the
Add: Pick points button has been used to hatch the square but not the triangle simply by
selecting the point inside the square but outside the triangle (using the default settings of the
dialog box).

Figure 13-11  Defining multiple hatch boundaries by selecting a point
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Tip
When you have selected a point within an area to hatch and you realize you have selected the
wrong area, you can enter U or UNDO at the Command prompt to undo the last selection.
You can also undo a hatch pattern you have already applied to an area by entering UNDO at
the Command prompt.

Boundary Definition Error. AutoCAD LT
displays different types of Boundary Definition
Error dialog boxes, depending on the kind of
error occurred while selecting the boundary. For
example, if you pick a point inside any boundary
that is not closed, this dialog box informs you
that boundary is not closed, see Figure 13-12.
Choose the Look at it button and the system will
again check the area with respect to the gap
tolerance value specified in the Tolerance edit
box of the Hatch tab of the Hatch dialog box. If
you select the same boundary twice, this dialog
box will inform you that the boundary duplicates
an existing boundary.

Note
The default value of the gap tolerance is 0. As a result, the open area will not be selected for
hatching. Instead, the Boundary Definition Error dialog box is displayed. This dialog box
informs you that the hatch boundary is not closed.

Add-Select objects. This option in the Hatch dialog box lets you select objects that
form the boundary for hatching. It is useful when you have to hatch an object and
disregard objects that lie inside it or intersect with it. When you select this option,

AutoCAD LT will prompt you to select objects. You can select the objects individually or use
other object selection methods. In Figure 13-13, the Select Objects button is used to select the
triangle. This uses the triangle as the hatch boundary, and everything inside it. The text inside
the triangle, in this case, also gets hatched. To avoid hatching of such internal objects, select
them at the next Select Objects prompt. In Figure 13-14, the text is selected to exclude it from
hatching. When using the Pick Points option, the text automatically gets selected to be excluded
from the hatching.

Tip
If you have an area to be hatched that has many objects intersecting with it, it is easier to select
the entire object to be hatched rather than choosing the internal points within each of the
smaller regions created by the intersection.

You can also turn off layers that contain text or lines that make it difficult for you to select
hatch boundaries.

Figure 13-12  The  Boundary Definition
Error dialog box
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Remove boundaries. This option is used to exclude boundaries and islands from  the
hatching area. Boundaries inside another boundary are known as islands. If you choose
the Pick Points button to hatch an area, the inside boundaries also known as islands are

not hatched by default. But, if you want to hatch the islands, you can choose the
Remove Boundaries button in the Hatch dialog box. This applies, for example, if you have
a rectangle with circles within, as shown in Figure 13-15. You can use the Pick Points option to
select a point inside the rectangle; AutoCAD LT will select both the circles and the rectangle. To
remove the circles (islands), you can use the Remove Islands option. When you select this
option, AutoCAD LT will prompt you to select the islands to be removed. Select the islands to
be removed and press ENTER to return to the dialog box. Choose OK to apply the hatch.
Similarly, you can remove boundaries.

Tip
It may be a good idea to use the Select Objects option to select the object containing islands,
if you want to remove the islands from the hatching area.

Figure 13-14  Using the Select Objects button
to exclude the text from hatching

Figure 13-13  Using the Select Objects button to
specify the hatching boundary

Figure 13-15  Using the Remove Islands option to
remove islands from the hatch area
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Recreate boundaries. This option is required while editing a hatch and is used to
recreate boundaries from an existing hatch. On choosing this button, the dialog box is
temporarily closed and you are prompted to specify whether you want to recreate

boundaries as a region or as a polyline. You can also associate the hatch to the new boundary.

View Selections. This option lets you view the selected boundaries before you apply
the hatch pattern. This option is not available when you have not selected any points or
boundaries. When you choose the View Selections button, the dialog box closes

temporarily and the selected boundaries in the drawing are displayed as highlighted.

Options Area
The options available in this area allow you to specify the draw order and composition of the hatch.

Associative
This radio button is selected by default, which implies that when you modify the boundary of the
hatch object, the hatch patterns  will be automatically updated to fill up the new area. One of the
major advantages with the associative hatch feature is that you can edit the hatch pattern or edit
the geometry that is hatched without having to modify the associated pattern or boundary
separately. After editing, AutoCAD LT automatically regenerates the hatch and the hatch geometry
to reflect the changes. The hatch pattern can be edited by using the HATCHEDIT command
and the hatch geometry can be edited by using grips or AutoCAD LT editing commands.

Create separate hatches
While hatching multiple closed areas that are not nested together, selecting this check box
ensures that a separate hatch is created for each closed area. If this check box is cleared, a single
hatch is created for all the selected closed areas.

Draw order
The drop-down list is used to assign a draw order to the hatch. If you want to send the hatch
behind all the entities, select the Send to back option. Similarly, if you want to place the hatch
in front of all the entities, select the Bring to front option. If you want to place the hatch behind
the hatch boundary, select Send behind boundary. Similarly, if you want to place the hatch in
front of the boundary, select Bring in front of boundary. You can also select the Do not assign
option, if you do not want to assign the draw order to the hatch.

Inherit Properties
The Inherit properties button is available below the Options area and is used to hatch
the specified boundaries using the properties of an existing hatch. When you invoke the
HATCH command and choose the Inherit Properties button, the following

command sequence appears. Note that this prompt sequence does not appear when you specify
the area to hatch first and then choose the Inherit Properties button.

Select hatch object: Select the object from which you have to inherit the hatch pattern.
Inherited Properties: Name <current>, Scale <current>, Angle <current>
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Pick internal point or [Select objects/remove Boundaries]: Pick a point inside the object to hatch.
Selecting everything visible...
Analyzing the selected data...
Pick internal point or [Select objects/remove Boundaries]: �

When you press ENTER, the Hatch dialog box reappears with the name of the inherited hatch
pattern in the Pattern edit box. The inherited hatch pattern is also displayed in the Swatch box.
The selected pattern now becomes the current hatch pattern. If you then want to adjust the hatch
properties, such as the angle or scale of the pattern, you can do so.

Preview
This button is used to preview the hatching before it is actually applied. This option is available
only after you have selected the area to be hatched. When you choose the Preview button, the
dialog box is temporarily closed and the object selected for hatching is temporarily filled with
the specified hatch pattern. You can also preview the drawing by right-clicking in the drawing
area, after selecting the boundary and choosing Preview from the shortcut menu. After previewing
the drawing, pick a point on the screen or press ESC to redisplay the Hatch dialog box so that
you can make modifications in the hatching operation. You can also press ENTER or right-click
after previewing the drawing to accept the hatching and apply it to the selected boundary. Note
that because you accept the current hatch settings by pressing ENTER or by right-clicking; the
HATCH command is completed and the Hatch dialog box is not displayed.

In this exercise, you will hatch the front section view of the drawing in Figure 13-16 using the
hatch pattern for brass. Two views, top, and front are shown. In the top view, the cutting plane
line indicates how the section is cut and the front view shows the full section view of the object.
The section lines must be drawn only where the material is actually cut.

Exercise 2 Mechanical

Figure 13-16  Drawing for Exercise 2



13-16                                                                                            AutoCAD LT 2006 for Designers
©

 C
A

D
C

IM
 T

ec
hn

ol
og

ie
s,

 U
S

A
. F

or
 o

nl
in

e 
tr

ai
ni

ng
, c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

Hatch Origin Area
A hatch pattern is always drawn with reference to some specified origin. The options available in
Hatch Origin Area allows you to specify origin for the hatch.

Use current origin
By default, the Use current origin radio button is selected. This implies that the origin of the
hatch pattern to be created is the origin of the current drawing.

Specified origin
When you select the Specified origin radio button, other options available in hatch Origin
Area are highlighted. Choose the Click to set new origin button and specify the origin point
for the hatch pattern in the drawing area. Select the Default to boundary extents check box; the
drop-down list is now available and you can select the options available in the drop-down list to
specify the origin of hatch pattern. If you select the Bottom left option from the drop-down list,
the origin of the hatch pattern will be at the bottom left corner of the boundary. The preview
corresponding to the option chosen is displayed in the preview area at the right of the drop-down
list. Selecting the Store as default origin check box stores the origin just selected as the default
origin for all the hatch patterns.

MORE OPTIONS
When you choose the More Options button available on the right of the Help button in the
Hatch dialog box, it expands and provides the following options.

Islands Area
The options in this area are used to specify the island detection method of creating the hatch.
These options are discussed next.

Island detection
The options available under the Island area are available only if the Island detection check box
is selected. When the checkbox is selected, the method of island detection is the Flood type.
When the checkbox is cleared the island detection is the Ray Casting type. The two methods of
island detection are discussed next.

Flood. This method of defining the hatch boundary includes the islands as the boundary
objects. This is the default method of island detection.

Ray Casting. This method casts rays in all directions or a particular direction from the point
specified to the nearest object and then traces the boundary in a counterclockwise direction,
thus excluding islands as boundary objects. Ray casting is discussed later in detail.

Island display style
These options are used to select the style of the island detection during hatching (Figure 13-17).
There are three styles available: Normal, Outer, and Ignore. To select a particular style, you can
select the corresponding radio button. The effect of using the particular style is displayed in the
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form of an illustration in the image tile placed above the particular radio button and is also
shown in Figure 13-18. You can also choose the image tiles to select a particular island detection
style.

Note
The selection of an island detection style carries meaning only if the objects to be hatched are
nested (that is, one or more selected boundaries is within another boundary).

Normal. The Normal style is selected by default. This style hatches inward starting at the outermost
boundary. If it encounters an internal boundary, it turns off the hatching. An
internal boundary causes the hatching to turn off until another boundary is encountered. In this
manner, alternate areas of the selected object are hatched, starting with the outermost area.
Thus, areas separated from the outside of the hatched area by an odd number of
boundaries are hatched, while those separated by an even number of boundaries are not.

Outer. This particular option also lets you hatch inward from an outermost boundary, but the
hatching is turned off if an internal boundary is encountered. Unlike the previous case, it does
not turn the hatching on again. The hatching process, in this case, starts from both ends of each
hatch line; only the outermost level of the structure is hatched, hence, the name Outer.

Ignore. In this option, all areas bounded by the outermost boundary are hatched. The option
ignores any hatch boundaries that are within the outer boundary. All islands are completely
ignored and everything within the selected boundary is hatched.

Tip
It is also possible to set the pattern and the island detection style at the same time by using the
HPNAME system variable. AutoCAD LT stores the Normal style code by adding N to the
pattern name. Similarly, O is added for the Outer style, and I for the Ignore style to the value
of the HPNAME system variable. For example, if you want to apply the BOX pattern using
the outer style of island detection, you should enter the HPNAME value to be BOX, O. Now,
when you apply the hatch pattern, the BOX pattern is applied using the outer style of hatching.

Figure 13-18  Using hatching stylesFigure 13-17  Island detection styles
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Note
The Normal, Outer, and Ignore options are also available in the shortcut menu when you select
an internal point in the drawing object and right-click in the drawing area. The shortcut menu
shall be discussed later.

Boundary retention Area
When you select an internal point in a region to be hatched, a boundary is created around it. By
default, these boundaries are removed as soon as the hatch pattern is applied. The Boundary
retention area provides options that allow you to specify whether these boundaries are to be
retained as objects or not. You can also specify the type of object it can be saved as.

Retain boundaries check box. The Retain boundaries check box is cleared by default,
which implies that the hatch boundaries are not saved. If you select this check box, you can
retain the defined boundary. When a hatching is successful and you want to keep the boundary
as a polyline or region so that you can use it again, you can select the Retain boundaries check
box. When you select this check box, the Object type drop-down list is available.

Object type drop-down list. The Object type drop-down list is available when you select the
Retain boundaries check box. From this list, you can select the type of object AutoCAD LT will
create when you define a boundary for hatching. It has two options: Polyline and Region.
Polyline is selected by default and the boundary created around the hatch area is a polyline.
Similarly, when you select Region, the boundary of the hatch area is a region. Regions are
two-dimensional areas that can be created from closed shapes or loops.

Boundary set Area
When hatching takes place normally, AutoCAD LT evaluates the entire drawing visible on the
screen to determine the boundary. For larger drawings, this may take a lot of time and therefore,
slow down the process of hatching. The Boundary set area provides options that allow you to
specify what is considered when hatching. You can either select an option from the
drop-down list or you can create a new boundary set. The boundary set comprises the objects
that the HATCH command uses when constructing the boundary. The default boundary set is
Current viewport, which comprises everything that is visible in the current viewport. Boundary
hatching is made faster by specifying a boundary set because, in this case, AutoCAD LT does not
have to examine everything on screen.

This option allows you to define a boundary area so that only a specific portion of the drawing
is considered for hatching. You use this option to create a new boundary set. When you choose
the New button, the dialog box is temporarily cleared from the screen to allow the selection of
objects to be included in the new boundary set. While constructing the boundary set, AutoCAD LT
uses only those objects that you select and that are hatchable. If a boundary set already exists, it
is replaced by the new one. If you do not select any hatchable objects, no new boundary set is
created. AutoCAD LT retains the current set, if there is any. Once you have selected the objects
to form the boundary set, press ENTER and the dialog box reappears on the screen. You will
notice that Existing Set gets added to the drop-down list. When you invoke the HATCH command
and you have not formed a boundary set, there is only one option, Current Viewport, available
in the drop-down list. The benefit of creating a selection set is that when you select a point or
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select the objects to define the hatch boundary, AutoCAD LT will search only for the objects that
are in the selection set. By confining the search to the objects in the selection set, the hatching
process is faster. If you select an object that is not a part of the selection set, AutoCAD LT ignores
it. When a boundary set is formed, it becomes the default for hatching until you exit the HATCH
command or select the Current Viewport option from the drop-down list.

Tip
To improve the hatching speed in large drawings, you should zoom into the area to be hatched,
so that defining the boundary to be hatched is easier. Also, since AutoCAD LT does not have to
search the entire drawing to find hatch boundaries, the hatch process gets faster.

Gap Tolerance Area
The Gap tolerance edit box is used to set the value up to which the open area will be considered
closed when selected for hatching, using the Pick Points method. The default value of the gap
tolerance is 0. As a result, the open area will not be selected for hatching. You can set the value
of the gap tolerance using the Gap tolerance edit box. If the gap in the open area is less than the
value specified in this edit box, the area will be considered closed and will be selected for
hatching.

Inherit Options Area
The options available in this area are used to set the hatch origin while working with the
Inherit Properties tool. By default, the Use current origin radio button is selected because of
which, the current origin will be taken as the hatch origin. If you select the Use source hatch
origin radio button, the hatch pattern will accept the origin of the source hatch as the origin of
the current hatch pattern.

RAY CASTING
You can use the  ray casting  technique to define a hatch boundary. In ray casting, AutoCAD LT
casts an imaginary ray in all directions or in a particular specified direction and locates the
object that is nearest to the point you have selected. After locating the object, it takes a left turn
to trace the boundary and the boundary gets highlighted. If the point you have specified lies
within the highlighted boundary, the islands within are ignored and the entire object is hatched.
But, if the point lies outside the highlighted boundary, an error message is displayed and you
are asked to select another point. Ray casting has five options: Nearest, +X, -X, +Y, and -Y, and
Angle. All these options are available when you use the -HATCH command. But, when you are
using the HATCH command, only the Nearest option can be used.

Ray Casting Using the HATCH Command
When you invoke the HATCH command, the Hatch dialog box is displayed. Clear the Island
detection check box in Islands area. Choose the Pick Points button. The dialog box closes
temporarily to allow you to specify a point for ray casting. In Figure 13-19, depending upon the
location of the specified point, a boundary object is selected. If you select a point close to the
outer circle, the circle gets highlighted as the hatching boundary. This is because imaginary rays
are cast from the specified point and the circle is the nearest closed boundary available. When
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you press ENTER,  the dialog box returns; choose the Preview button to see the preview of the
hatching. You will notice that the entire circle is hatched and the inner objects (rectangle and
triangle) have been ignored (Figure 13-20).

Now, for the next time, select a point inside the circle but closer to the inner rectangle. The
inner rectangle gets highlighted as it is nearest to the specified point and a Boundary
Definition Error dialog box (Figure 13-21) is displayed suggesting the specified point is not
within the highlighted boundary. The Boundary Definition Error dialog box has two buttons:
OK and Look at it. If you choose OK, the dialog box is closed
and you can select another point. If you choose Look at it,
AutoCAD LT displays the highlighted boundary and the position
of the specified point is shown marked with an (X) marker. An
AutoCAD LT Message box is displayed with the message:
Press ENTER to continue. You can press ENTER or choose
OK to continue and specify another point.

Using the -HATCH Command
You can also create hatch patterns from the command line using the -HATCH command. The
-HATCH command is especially useful when you want to avoid boundary definition errors, by
forcing the ray casting in a particular direction, or want to use other  ray casting options that are
not available through the dialog box. These options control the direction, in which AutoCAD
LT casts the ray to form a hatch boundary. When using the -HATCH command, the dialog box
is bypassed and the available options are Nearest, +X, -X, +Y, and -Y. The prompt sequence is
given next.

Command: -HATCH
Current hatch Pattern: ANSI31
Specify internal point or [Properties/Select objects/draW boundary/removeBoundaries/
Advanced/DRaw order/Origin]: A �
Enter an option [Boundary set/Retain boundary/Island detection/Style/Associativity/Gap
tolerance/separate Hatches]: I

Figure 13-20  The result of using the Nearest
ray casting option

Figure 13-19  Specifying a point closer to the
outer circle during hatching using ray casting

Figure 13-21  The Boundary
Definition Error dialog box
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Do you want island detection? [Yes/No] <Y>: N
Enter type of ray casting [Nearest/+X/-X/+Y/-Y/Angle] <Nearest>: Specify an option.
Enter an option [Boundary set/Retain boundary/Island
detection/Style/Associativity/Gap tolerance/separate Hatches]: �
Current hatch pattern:  ANSI31
Specify internal point or [Properties/Select objects/draW boundary/remove
Boundaries/Advanced/DRaw order/Origin]: Select a point.

Nearest. The Nearest option is the default option. When this option is used, AutoCAD LT
casts an imaginary ray from the specified point to the nearest hatchable object, then takes a turn
to the left, and continues the tracing process in an effort to form a boundary around the internal
point. To make this process work properly, the point you select inside the boundary should be
closer to the boundary than any other object that is visible on the screen.

+X, -X, +Y, and -Y options. These options can be explained better by studying Figure 13-26.
Figure 13-22(a) shows that the points that can be selected are those that are nearest to the right
edge of the circumference of the circle because the ray casting takes place in the direction of the
positive X. If you select a point on the left of the rectangle that is placed inside the circle, no
valid boundary is detected. This is because when you have selected this point, rays are cast
horizontally from it in the positive X direction and the rectangle is encountered, which is
invalid, since this point is not within the highlighted boundary.

Figure 13-22(b) shows that the points that can be used for selection are those that are nearest to
the left edge of the circle because the ray casting takes place in the negative X direction. Any
point selected on the right of the rectangle casts rays toward the negative X direction and
encounters the rectangle, which is again an invalid boundary for the selected point.

Figure 13-22  Valid points for casting a ray in different directions to
select the circle as boundary
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In Figure 13-22(c), the ray casting takes place in the positive Y direction, and so the points that
can be used for selection are the ones closest to the upper edge of the circle. If a point is selected
below the rectangle, which is placed within the circle, rays are cast in the positive direction
and a rectangle is encountered, which is an invalid boundary for the selected point.

In Figure 13-22(d), the ray casting takes place in the negative Y direction, and so the internal
points that can be selected are the ones closest to the lower edge of the circle. When a point is
selected above the rectangle, rays are cast in the negative Y direction and the rectangle is
encountered, which is an invalid boundary for the selected point.

The valid areas for selecting points for the +X, -X, +Y, and -Y options of ray casting are shown
in Figures 13-23 and 13-24 as shaded. Points selected within the unshaded portions result in
boundary errors.

Note
The options of the -BHATCH command are the same as those in the -HATCH command. From
this release, the working of the BHATCH and HATCH commands have been made similar. You
can use either of the commands.

Figure 13-23  Valid areas (shaded) for selecting points for the -X and +X options of ray casting

Figure 13-24  Valid areas (shaded) for selecting points for the -Y and +Y options of ray casting



Hatching Drawings                                                               13-23

©
 C

A
D

C
IM

 T
ec

hn
ol

og
ie

s,
 U

S
A

. F
or

 e
ng

in
ee

ri
ng

 s
er

vi
ce

s,
 c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

The HATCH Shortcut Menu
After invoking the HATCH command and selecting a point that
lies in the interior of the object to be hatched, or the object to be
hatched itself, right-click to display the shortcut menu
(Figure 13-25). This shortcut menu displays the options that are
also available through the Hatch dialog box. If you choose
Preview, you can preview the hatching before applying it. If you
choose Enter, the dialog box reappears. Choosing Clear All
removes all the previous selections made. You can also select
another island detection mode and also change from one method
of hatching to another. Choose the Remove Boundaries option
to remove the boundaries from the selected hatching area. You
can specify the hatch origin using the options available  in the
Hatch Origin cascading menu.

HATCHING THE DRAWINGS USING THE TOOL PALETTES

You can use the TOOL PALETTES window shown in
Figure 13-26 to insert predefined hatch patterns and
blocks in the drawings. By default, AutoCAD LT displays

TOOL PALETTES as a window on the right of the drawing
area. A number of tabs are available in this window, such as
Command Tools, Hatches, Civil/Structural, Electrical, and so
on. In this chapter, you will learn to insert Imperial and ISO
hatches in the Hatches tab of the TOOL PALETTES window.
The Imperial Hatches area provides the options to insert the
hatch patterns that are created using the Imperial units. The
ISO Hatches area provides the options to insert the hatch patterns
that are created using the Metric units. You will notice that the
hatch patterns provided in both these areas are similar. The
basic difference between the two tabs is their scale factor.

Tip
The TOOL PALETTES window can be turned on and off
by pressing the CTRL+3 keys.

AutoCAD LT provides two methods to insert the predefined hatch
patterns from the TOOL PALETTES window: Drag and Drop
method and Select and Place method. Both these methods are
discussed next.

Toolbar: Standard > Tool Palettes Window
Menu: Tools > Tool Palettes Window
Command: TOOLPALETTES

Figure 13-26  The TOOL
PALETTES window

Figure 13-25  The HATCH
shortcut menu
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Drag and Drop Method
To insert the predefined hatch pattern from the TOOL PALETTES using this method, move
the cursor over the desired predefined pattern in the TOOL PALETTES. You will notice that as
you move the cursor over the hatch pattern, the hatch icon gets converted into a 3D icon. Also,
a tooltip is displayed that shows the name of the hatch pattern. Press and hold the left mouse
button and drag the cursor within the area to be hatched. Release the left mouse button, and you
will notice that the selected predefined hatch pattern is added to the drawing.

Select and Place Method
You can also add the predefined hatch patterns to the drawings using the select and place
method. To add the hatch pattern, move the cursor over the desired pattern in the TOOL
PALETTE. The pattern icon is changed to a 3D icon. Press the left mouse button; the selected
hatch pattern is attached to the cursor and you are prompted to specify the insertion point of the
hatch pattern. Move the cursor within the area to be hatched and press the left mouse button.
The selected hatch pattern is inserted at the specified location.

Modifying the Properties of the Predefined Patterns
Available in the TOOL PALETTES
To modify the properties of the predefined hatch patterns, move the cursor over the hatch
pattern in the TOOL PALETTES and right-click on it to display the shortcut menu. Using the
options available in this shortcut menu, you can cut or copy
the desired hatch pattern available in one tab of
TOOL PALETTES and paste it on the other tab. You can
also delete and rename the selected hatch pattern using the
Delete Tool and Rename options, respectively. To modify
the properties of the selected hatch pattern, choose
Properties from the shortcut menu, as shown in Figure 13-27.
The Tool Properties dialog box is displayed, as shown in
Figure 13-28.

In the Tool Properties dialog box, the name of the selected hatch pattern is displayed in the
Name edit box. You can also rename the hatch pattern by entering the new name in the Name
edit box. The Image area available on the left of the Name edit box displays the image of the
selected hatch pattern. If you enter a description of the hatch pattern in the Description text
box, it is stored with the hatch definition in the TOOL PALETTES. Now, when you move the
cursor over the hatch pattern in TOOL PALETTES and pause for a second, the description of
the hatch pattern appears along with its name in the tooltip. The Tool Properties dialog box
displays the properties of the selected hatch pattern under the following categories.

Pattern
In this category, you can change the pattern type, pattern name, angle, and scale of the selected
pattern. You can modify the spacing of the User defined patterns in the Spacing text box. Also,
the ISO pen width of the ISO patterns can be redefined in the ISO pen width text box. The
Double drop-down list is available only for the User-defined hatch patterns. You can select Yes

Figure 13-27  Choosing Properties
from the shortcut menu
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Figure 13-28  The Tool Properties dialog box

or No from the Double drop-down list to determine the hatch pattern to be doubled at right
angles to the original pattern or not. When you choose the [...] button in the Type property
field, AutoCAD LT displays the Hatch Pattern Type dialog box. You can select the type of hatch
pattern from the Pattern Type drop-down list. If the Predefined pattern type is selected, you
can specify the pattern name by either selecting it from the Pattern  drop-down list or from the
Hatch Pattern Palette dialog box displayed on choosing the Pattern button. Similarly, if you
select the Custom pattern type, you can enter the name of the  custom pattern in the Custom
Pattern edit box. If you select the User defined pattern type, both the Pattern drop-down list
and the Custom Pattern edit box are not available.

General
In this category, you can specify the general properties of the hatch pattern such as color, layer,
linetype, plot style, and line weight for the selected hatch pattern. The properties of a particular
field can be modified from the drop-down list available on selecting that field.

When you select a particular field in the Tool Properties dialog box, its function is displayed in
the display box available at the bottom of the dialog box. Choose OK to apply the changes and
close the dialog box.

Tip
You can cut, copy, or rename the selected hatch pattern available on TOOL PALETTES using
the shortcut menu.
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Figure 13-29  Hatching around dimension, multiline
text, and attributes

Toolbar: Modify II > Hatch
Menu: Modify > Object > Hatch
Command: HATCHEDIT

HATCHING AROUND TEXT, DIMENSIONS, AND
ATTRIBUTES
When you select a point within a boundary to be hatched and if it contains text, dimensions,
and attributes, the hatch lines do not pass through the text, dimensions, and attributes present
in the object being hatched by default. AutoCAD LT places an imaginary box around these
objects that does not allow the hatch lines to pass through it. Remember that if you are using the
select objects option to select objects to hatch, you must select the text/attribute/shape along with
the object in which it is placed when defining the hatch boundary. If multiple line text is to
be written, the MTEXT command is used. You can also select both the boundary and the text
when using the window selection method. Figure 13-29 shows you how hatching takes place
around multiline text, attributes, and dimensions.

EDITING HATCH PATTERNS
Using the HATCHEDIT Command

The HATCHEDIT command (Figure 13-30) can be used to
edit the hatch pattern. When you invoke this command
and select the hatch for editing, the Hatch Edit dialog box
(Figure 13-31) is displayed on the screen.

The Hatch Edit dialog box can also be invoked from the shortcut menu or by double-clicking on
the hatch pattern. After selecting a hatched object, right-click in the drawing area, and choose
Hatch Edit from the shortcut menu.

Figure 13-30  Choosing Edit
Hatch from the Modify II toolbar
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AutoCAD LT will display the Hatch Edit dialog box, where the hatch pattern can be changed or
modified accordingly. This dialog box is the same as the Hatch dialog box, except that only the
options that control the hatch pattern are available. These available options work in the same
way as they do in the Hatch dialog box.

The Hatch Edit dialog box has one tab just like the Hatch dialog box. The Hatch tab. In this,
you can redefine the type of hatch pattern by selecting another type from the Type drop-down
list. If you are using the  Predefined pattern, you can select a new hatch pattern name from the
Pattern drop-down list. You can also change the scale or angle by entering new values in the
Scale or Angle edit box. When using the User defined pattern, you can redefine the spacing
between the lines in the hatch pattern by entering a new value in the Spacing edit box. If you are
using the Custom pattern type, you can select another pattern from the Custom pattern
drop-down list. You can also redefine the island detection style by selecting either of the Normal,
Outer, or Ignore styles from the Islands area of the dialog box. If you want to copy the properties
from an existing hatch pattern, choose the Inherit Properties button, and then select the hatch
whose properties you want to be inherited. You can also change the draw order of the hatch
patter using the options available in the Draw Order area. If the Associative radio button in the
Options area of the dialog box is selected, the pattern is associative. This implies that whenever
you modify the hatch boundary, the hatch pattern is automatically updated.

Figure 13-31  The Hatch Edit dialog box
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Toolbar: Standard > Properties
Menu: Modify, Tools > Properties
Command: PROPERTIES

Figure 13-32  ANSI31 hatch pattern Figure 13-33  Using the HATCHEDIT command
to edit the hatch pattern

Note
If a hatch pattern is associative, the hatch boundary can be edited using grips and editing
commands and the associated pattern is modified accordingly. This is discussed later.

In Figure 13-32, the object is hatched using the ANSI31 hatch pattern. With the HATCHEDIT
command, you can edit the hatch using the Hatch Edit dialog box to change the hatch to the
one shown in Figure 13-33. You can also edit an existing hatch through the command line by
entering -HATCHEDIT at the Command prompt.

IGNORING HATCH PATTERN ENTITIES WHILE SNAPPING
In the previous releases of AutoCAD LT, the hatch pattern elements were even considered, while
trying to snap to a point close to them. This causes a problem in snapping to the exact point.
AutoCAD LT 2006 allows you to set the option that ensures that the hatch pattern elements are
not considered while snapping. This option is set using the Ignore hatch objects check box in
the Object Snap Options area of the Drafting tab of the Options dialog box. This check box is
selected by default.

Using the PROPERTIES Palette

You can also use the PROPERTIES command to edit the hatch pattern. When you
select a hatch pattern for editing, and invoke the PROPERTIES command, AutoCAD LT
displays the PROPERTIES palette for the hatch, see Figure 13-34. You can also invoke

the PROPERTIES palette by selecting the hatch pattern and right-clicking to display a
shortcut menu. Choose Properties here; the PROPERTIES palette is displayed. This palette
displays the properties of the selected pattern under the following categories.
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General
In this category, you can change the general pattern properties
like color, layer, linetype, linetype scale, lineweight, and so
on. When you click on the field corresponding to a particular
property, a drop-down list is displayed from where you can
select an option or value. Whenever a drop-down list does not
get displayed, you can enter a value in the field itself.

Pattern
In this category, you can change the pattern type, pattern
name, angle, scale, spacing, associativity, and island detection
style properties of the pattern. In the case of ISO patterns,
you can redefine the ISO pen width of the pattern and you
can also modify the spacing of the User defined patterns.
You can also determine whether you want to have a User
defined pattern as double or not. When you choose the [...]
button in the Type property field, AutoCAD LT displays the
Hatch Pattern Type dialog box, see Figure 13-35. Here, you
can select the type of hatch pattern from the Pattern Type
drop-down list. If you have selected a Predefined pattern type,
you can select  a  pattern name  from  the  Pattern  drop-down
list or choose the Pattern button to display the Hatch Pattern
Palette dialog box. You can then select a pattern here in one
of the tabs and then choose OK to exit the dialog box. Now,
choose OK in the Hatch Pattern Type dialog box to return to
the PROPERTIES palette. You will notice that the pattern
name you have selected is displayed in the Pattern name field.
Similarly, if you select the Custom pattern type, you can
enter the name of the custom pattern in the Custom Pattern
edit box. If you select a User defined pattern type, both
the Pattern Type drop-down list and the Custom Pattern
edit box are not available. When you click in the Pattern
name property field, the [...] button is displayed. When
you choose the [...] button, the Hatch Pattern Palette dialog
box is displayed with the ANSI31 pattern selected. The
values of the angle, scale, and spacing properties can be
entered in the corresponding fields. A value for the ISO
pen width can be selected from the ISO pen width
drop-down list. For user-defined hatch patterns, you can
select Yes or No from the Double drop-down list to specify
if you want the hatch pattern to double at right angles to the original pattern or not. You can also
select Yes or No from the Associative drop-down list to determine if a pattern is associative or
not. Similarly, you can select an island detection style from the Island detection style
drop-down list.

Figure 13-35  The Hatch Pattern
Type dialog box

Figure 13-34  The PROPERTIES
palette (Hatch)
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Figure 13-36  The result of using grips to edit the
hatch boundary of the object shown in Figure 13-33

Tip
It is more convenient to choose the [...] button in the Pattern Type edit box to display the
Hatch Pattern Type dialog box and enter both the type and name of the pattern at the same
time.

Geometry
In this category, the elevation of the hatch pattern can be changed. A new value of elevation for
the hatch pattern can be entered in the Elevation field. This category also displays the area and
the cumulative area of the hatch.

EDITING HATCH BOUNDARY
Using Grips
One of the ways you can edit the hatch boundary is by using grips. You can select the hatch
pattern or the hatch boundaries. If you select the hatch pattern, the hatch highlights and a grip
is displayed at the centroid of the hatch. A centroid for a region that is coplanar with the XY
plane is the center of that particular area.
However, if you select an object that defines
the hatch boundary, the object grips are
displayed at the defining points of the selected
object. Once you change the boundary
definition, and if the hatch pattern is
associative, AutoCAD LT will reevaluate the
hatch boundary and then hatch the new area.
When you edit the hatch boundary, make sure
that there are no open spaces in it.
AutoCAD LT will not create a hatch if the outer
boundary is not closed. Figure 13-36 shows
the result of  moving the circle and text, and
shortening the bottom edge of the hatch
boundary of the object shown in Figure 13-33.
The objects were edited by using grips and
since the pattern is associative, when
modifications are made to the boundary object, the pattern automatically fills up the new area. If
you select the hatch pattern, AutoCAD LT will display the hatch object grip at the centroid of
the hatch. You can select the grip to make it hot and then edit the hatch object. You can stretch,
move, scale, mirror, or rotate the hatch pattern. Once an editing operation takes place on the
hatch pattern, it may be moved, rotated, or scaled; then, the associativity is lost and AutoCAD
LT displays the message: “Hatch boundary associativity removed.”

The Retain boundaries check box in the Hatch dialog box is cleared when a hatch is created by
default. Hence, all objects selected or found by the selection or point selection processes during
hatch creation are associated with the hatch as boundary objects. Editing any of them may affect
the hatch. If, however, the Retain boundaries check box was selected when the hatch was
created, only the retained polyline boundary created by HATCH is associated with the hatch as
its boundary object. Editing it will affect the hatch, and editing the objects selected or found by
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selection or point selection processes during the hatch created will have no effect on the hatch.
You can, of course, select and simultaneously edit the objects selected or found by the selection
or point selection processes, as well as the retained polyline boundary created by the HATCH
command.

Trimming the Hatch Patterns
One of the recent additions in editing hatches is that you are now allowed to trim the hatch
patterns using a cutting edge. For example, refer to Figure 13-37. This figure shows a drawing
before trimming the hatch. In this drawing, the outer loop was selected as the object to be
hatched. This is the reason the space between the two vertical lines on the right is also
hatched. Figure 13-38 shows the same drawing after trimming the hatch using the vertical lines
as the cutting edge. You will notice that even after trimming some of the portion of the hatch, it
is a single entity.

Using AutoCAD LT Editing Commands
When you use the editing commands such as MOVE, ROTATE, SCALE, and STRETCH,
associativity is maintained, provided all objects that define the boundary are selected for editing.
If any of the boundary-defining objects is missing, the associativity will be lost and AutoCAD LT
will display the message Hatch boundary associativity removed. When you rotate or scale an
associative hatch, the new rotation angle and the scale factor are saved with the hatch object
data. This data is then used to update the hatch. When using the ARRAY, COPY, and
MIRROR commands, you can array, copy, or mirror just the hatch boundary, without the hatch
pattern. Similarly, you can erase just the hatch boundary, using the ERASE command and
associativity is removed. If you explode an associative hatch pattern, the associativity between
the hatch pattern and the defining boundary is removed. Also, when the hatch object is exploded,
each line in the hatch pattern becomes a separate object.

When the original boundary objects are being edited, the associated hatch gets
updated, but new boundary objects do not have any effect. For example, when you have a square
island within a circular boundary and then you erase the square, the hatch pattern is updated to

Figure 13-37  Before trimming the hatch Figure 13-38  After trimming the hatch using the
vertical lines as the cutting edge
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Figure 13-40  Aligning hatch patterns using the
SNAPBASE variable

Figure 13-39  Hatching inserted blocks

fill up the entire circle. But, once the island is removed, another island cannot be added, since
it was not calculated as a part of the original set of boundary objects.

HATCHING BLOCKS AND XREF DRAWINGS
When you apply hatching to inserted blocks and xref drawings, their internal structure is treated
as if the block or xref drawing were composed of independent objects. This means that if you
have inserted a block that consists of a circle
within a rectangle and you want the internal
circle to be hatched, all you have to do is
invoke the Hatch dialog box and then choose
the Pick Points button to select a point within
the circle to generate the desired hatch, see
Figure 13-39. If you want to hatch a block using
the Select Objects option, the objects inside
the blocks should be parallel to the current
UCS. If the block is composed of objects such
as arcs, circles, or polyline arc segments, they
need not be uniformly scaled for hatching,
see Figure 13-39.

When you xref a drawing, you can hatch any part of the drawing that is visible. Similarly, when
you detach the xref drawing, the hatch pattern and its boundaries are not detached, although
the hatch boundary associativity is removed.

PATTERN ALIGNMENT DURING HATCHING
Pattern alignment is an important feature of hatching, since on many occasions you need to
hatch adjacent areas with similar or sometimes identical hatch patterns while keeping the adjacent
hatch patterns properly aligned. Proper
alignment of hatch patterns is taken care of
automatically by generating all lines of every
hatch pattern from the same reference point.
The reference point is normally at the origin
point (0,0). Figure 13-40 shows two adjacent
hatch areas. The area on the right is hatched
using the pattern ANSI32 at an angle of
0-degree and the area on the left is hatched
using the same pattern at an angle of
90-degree. When you hatch these areas, the
hatch lines may not be aligned, as shown in
Figure 13-40(a). To align them, you can
redefine the value of the SNAPBASE variable
before you apply the hatch to the area on the
left, so that the hatch lines are aligned, as
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shown in Figure 13-40(b). The reference point for hatching can be changed using the system
variable SNAPBASE. The command prompt sequence is given next.

Command: SNAPBASE
Enter new value for SNAPBASE <0.0000, 0.0000>: Enter the new reference point.

In this case, the endpoint of the hatch in the area on the right is selected as the new reference
point for hatching the area on the left. See Figure 13-40(b).

Note
The value of the SNAPBASE variable can also be set using the X base and Y base edit boxes
in the Snap area of the Drafting Settings dialog box (Snap and Grid tab).

Tip
You should set the base point back to (0,0) when you are done with hatching the object;
otherwise, the most recent value gets stored and is used the next time you apply a hatch pattern.

In this exercise, you will hatch the given drawing using the hatch pattern ANSI31. Use the
SNAPBASE variable to align the hatch lines shown in the drawing (Figure 13-41).

Figure 13-41  Drawing for Exercise 3

Exercise 3 Mechanical
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Figure 13-43  Using the BOUNDARY command
to create a polyline boundary

Figure 13-42  The Boundary Creation
dialog box

CREATING A BOUNDARY USING CLOSED LOOPS

The BOUNDARY command is used for creating a polyline or region around a selected point
within a closed area, in a manner similar to the one used for defining a hatch boundary. When
this command is invoked, AutoCAD LT displays the Boundary Creation dialog box, as shown
in Figure 13-42.

The options in the Boundary Creation dialog box are similar to those in the Hatch dialog box
discussed earlier. Although, only the options related to boundary selections are available, the
Pick Points button in the Boundary Creation dialog box is used to create a boundary by selecting
a point inside the object, whose boundary you want to create.

When you choose the Pick Points button, the dialog box is cleared from the screen temporarily
and you are prompted to select the internal point. Select a point that lies within the boundary of
the object. Once you select an internal point, a polyline or a region is formed around the
boundary (Figure 13-43). To end this process, press ENTER or right-click at the Select internal
point prompt. Whether the boundary created is a polyline or region is determined by the option
you have selected from the Object type drop-down list in the Boundary retention area. Polyline
is the default option. You can edit the boundary that has been created with the editing commands.
The boundary is selected by using the Last object selection option.

Similar to the HATCH command, you can also define a boundary set here by choosing the New
button in the Boundary set area of the dialog box. The dialog box will temporarily close to
allow you to select objects to be used to create a boundary. The default boundary set is current
viewport, which means everything visible in the current viewport consists of the boundary set.
As discussed earlier, the boundary set option is especially useful when you are working with large

Menu: Draw > Boundary
Command: BOUNDARY
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and complex drawings, where examining everything on the screen becomes a
time-consuming process.

The Boundary Creation dialog box also provides you the option of determining the island
detection method. The Island detection check box is available below the Pick Points button
and is selected by default. As a result, the island detection method is Flood type and islands are
included as boundary objects. If you clear this check box, the Ray casting method of island
detection is enabled, where rays shall be cast from the selected internal point in all directions
(by default, using the dialog box). The nearest closed object it encounters is used for boundary
creation. If the selected point does not lie within the encountered boundary, a Boundary
Definition Error dialog box is displayed and you have to select another internal point.

The -BOUNDARY command can be used if you want to bypass the dialog box and use the
command line. When using the command line, all the options (Nearest, +X, -X, +Y, and -Y) of
ray casting are available. When using the dialog box, only the Nearest option is available. The
different options of ray casting have been described earlier in the chapter.

Note
The HPBOUND system variable controls the type of boundary object created using the
BOUNDARY command. Its default value of 1 creates a polyline and if the value is 0, the object
created is a region.

Understand Figure 13-44 and then create the drawing shown in Figure 13-46 using the
BOUNDARY command to create a hatch boundary. Copy the boundary from the drawing
shown in Figure 13-45, and then hatch.

Exercise 4 Mechanical

Figure 13-44  Drawing for Exercise 4 Figure 13-45  Final drawing for Exercise 4
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Self-Evaluation Test

OTHER FEATURES OF HATCHING
1. In AutoCAD LT, the hatch patterns are separate objects. The objects store the information

about the hatch pattern boundary with reference to the geometry that defines the pattern for
each hatch object.

2. When you save a drawing, the hatch patterns are stored with the drawing. Therefore, the
hatch patterns can be updated even if the hatch pattern file that contains the definitions of
hatch patterns is not available.

3. If the system variable FILLMODE is 0 (Off), the hatch patterns are not displayed. To see
the effect of a changed FILLMODE value, you must use the REGEN command to
regenerate the drawing after the value has been changed.

4. You can edit the boundary of a hatch pattern even when the hatch pattern is not visible
(FILLMODE=0).

5. The hatch patterns created with earlier releases are automatically converted to
AutoCAD LT 2006 hatch objects when the hatch pattern is edited.

6. When you save an AutoCAD LT 2006 drawing in Release 2.0 format (DXF), the hatch
objects are automatically converted to Release 2.0 hatch blocks.

7. You can use the CONVERT command to change the pre-Release 97 hatch patterns to
AutoCAD LT 2006 objects. You can also use this command to change the pre-Release 97
polylines to AutoCAD LT 2006 optimized format to save memory and disk space.

Answer the following questions, and then compare your answers to those given at the end of
this chapter.

1. Different hatch patterns make it possible to distinguish between different parts or
components of an object. (T/F)

2. If AutoCAD LT does not locate the entered pattern in the acad.pat file, it searches for it in a
file with the same name as the pattern. (T/F)

3. When a boundary set is formed, it does not become the default for hatching. (T/F)

4. You can edit the hatch boundary and the associated hatch pattern by using grips. (T/F)
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5. The working of the __________ command and the __________ is made similar in this
release of AutoCAD LT.

6. One of the ways to specify a hatch pattern from the group of stored hatch patterns is by
selecting one from the __________ drop-down list.

7. The value you enter in the __________ edit box lets you rotate the hatch pattern with
respect to the X axis of the current UCS.

8. The __________ option in the Hatch dialog box lets you select objects that form the boundary
for hatching.

9. You can use the __________ option after you have selected the area to be hatched to see the
hatching before it is actually applied.

10. The selection of a hatch style carries meaning only if the objects to be hatched are __________.

Answer the following questions.

1. The HATCH command does not allow you to hatch a region enclosed within a boundary
(closed area) by selecting a point inside the boundary. (T/F)

2. A Boundary Definition Error dialog box is displayed if AutoCAD LT finds that the selected
point is not inside the boundary or that the boundary is not closed. (T/F)

3. The Gap tolerance edit box is used to set the value up to which the open area will be
considered closed when selected for hatching using the Pick Points method. (T/F)

4. When you use editing commands such as MOVE, SCALE, STRETCH, and ROTATE,
associativity is lost, even if all the boundary objects are selected. (T/F)

5. The hatching procedure in AutoCAD LT does not work on inserted blocks. (T/F)

6. Patterns drawn using the HATCH command are associative. (T/F)

7. If the Double hatch box is selected, which system variable is set to 1?

(a) HPSPACE (b) HPDOUBLE
(c) HPANG (d) HPSCALE

Review Questions
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8. The ISO Pen Width drop-down list is available only for which hatch patterns?

(a) ANSI (b) Predefined
(c) Custom (d) ISO

9. If you want to have the same hatching pattern, style, and properties as that of an existing
hatch on the screen, which button should you choose?

(a) Inherit Properties (b) Select Objects
(b) Pick Points (d) Remove Islands

10. Which variable can you use to align the hatches in adjacent hatch areas?

(a) SNAPBASE (b) FILLMODE
(c) SNAPANG (d) HPANG

11. The specified hatch spacing value is stored in which system variable?

(a) HPDOUBLE (b) HPANG
(c) HPSCALE (d) HPSPACE

12. One of the advantages of using the __________ command is that you don’t have to select
each object comprising the boundary of the area you want to hatch, as in the case of the
__________ command.

13. To select a custom hatch pattern, first select Custom from the Type drop-down list and then
select the name of a previously stored hatch pattern from the __________ drop-down list.

14. There are three hatching styles from which you can choose: __________, __________, and
__________.

15. If you select the __________ style, all areas bounded by the outermost boundary are hatched,
ignoring any hatch boundaries that lie within the outer boundary.
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Exercises

Exercise 5 Mechanical

Figure 13-46  Drawing for Exercise 5

Hatch the drawings in Figures 13-46 and 13-47 using the hatch pattern to match.

Figure 13-47  Drawing for Exercise 5
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Exercise 7 Mechanical

Figure 13-49  Drawing for Exercise 7

Exercise 6 General

Figure 13-48  Drawing for Exercise 6

Hatch the drawing in Figure 13-48 using the hatch pattern ANSI31. Use the SNAPBASE variable
to align the hatch lines, as shown in the drawing.

Figure 13-49 shows the top and front views of an object. It also shows the cutting plane line.
Based on the cutting plane line, hatch the front views in section. Use the hatch pattern of your
choice.
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Exercise 8 Mechanical

Figure 13-50  Drawing for Exercise 8

Figure 13-50 shows the top and front views of an object. Hatch the front view in full section. Use
the hatch pattern of your choice.

Figure 13-51 shows the front and side views of an object. Hatch the side view in half section. Use
the hatch pattern of your choice.

Exercise 9 Mechanical

Figure 13-51  Drawing for Exercise 9
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Exercise 10 Mechanical

Figure 13-52  Drawing for Exercise 10

Figure 13-52 shows the front view with broken section and top views of an object. Hatch the front
view as shown. Use the hatch pattern of your choice.
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Figure 13-53  Drawing for Exercise 11

Figure 13-53 shows the front, top, and side views of an object. Hatch the side view in section
using the hatch pattern of your choice.

Exercise 11 Mechanical
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Figure 13-55  Drawing for Problem Solving Exercise 2

Figure 13-54  Drawing for Problem Solving Exercise 1

Problem Solving Exercise 2 Mechanical

Problem Solving Exercise 1 Mechanical
Figure 13-54 shows an object with front and side views with aligned section. Hatch the side view
using the hatch pattern of your choice.

Figure 13-55 shows the front view, side view, and the detail “A” of an object. Hatch the side view
and draw the detail drawing as shown.
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Figure 13-56  Drawing for Problem Solving Exercise 3

Problem Solving Exercise 4 Mechanical

Figure 13-57  Drawing for Problem Solving Exercise 4

Problem Solving Exercise 3 Mechanical
Create the drawing shown in Figure 13-56. Assume the missing dimensions.

Create the drawing shown in Figure 13-57. Assume the missing dimensions.
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Answers to Self-Evaluation Test
1 - T, 2 - T, 3 - F, 4 - T, 5 - BHATCH, HATCH,  6 - Pattern, 7 - Angle, 8 - Select Objects,
9 - Preview, 10 - nested


